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GENERAL INFORMATION

+ General information
The website will be created in English, but additional languages will be added 
later on. This will allow to translate certain sections of the website if required.
The current alternative languages list consists of:
› French
› Spanish
› Portuguese
Currently the language switcher is disabled and only French is added as an 
extra language. The language switcher can be enabled in the control panel.

+ User rights
There will be 4 types of roles inside the website. Each role will have it’s own 
set of permissions:
› Public (Anonymous users)

This role is dedicated to the visitors of the website. This information does not 
require a login.

› Stakeholders
Read access to public and own group content.
Restricted Unions/EMS operators (ie not members), delivery agents

› EMS Cooperative members
Read access to public, stakeholders and own group content
EMS members/IB staff 

› EMS Unit/board
Creation of content and read access to public, stakeholders, cooperative members 
and own group content.
Staff/Board

The permissions will be set on a page basis. A page can be linked to a certain 
role. Each user inside the role can access the content.
For this a taxonomy term with the same name of the role will be added in 
combination with the taxonomy term permissions module.
Operators, members and board & unit require a login to access their dedicated 
pages.
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GENERAL INFORMATION

+ Paragraphs
To be able to make certain components on pages re-usable, a module called 
Paragraphs will be implemented.

The paragraph module allows to create a group of fields (textfields, images, 
links, …), that can be added to a certain content type.
Each paragraph can be added for a limited or unlimited amount of times to a 
certain field.

This way a page can be constructed using a combination of different 
components.

+ Focal point
A module will be added to allow to select a certain part of the image as the 
cropping focal point.
This will allow to select a certain point in an upload image as the center of the 
cropped image, which will avoid that the system crops the wrong part.

+ Global search
A global search using the default Drupal search will be provided to be able to 
search on content inside the website.

Only the current user roles content will be shown inside the search results. 
To make this possible a Search API implementation will take place.

We will display a search result exerpt compliant with the default Drupal 8 
behavior.
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GENERAL INFORMATION

+ Images
All images that could benefit from a search engine indexation will allow to set a 
an “alt” attribute.
For usability, icons and other control based elements will not contain an alt 
tag.

None of the images come from a library. Meaning that an image should be 
uploaded for each instance. Some exceptions exist from re-occuring icons.

+ Taxonomy
A taxonomy in Drupal is used to categorize content. By using a taxonomy, a 
content type can be used for multiple similar types of content. It also allows to 
filter on a content type by a certain set of given taxonomy terms.

An example of a taxonomy in this project could be an operator that provides 
an EMS service. The service would be the taxonomy in relation to the member 
content type.

+ Required fields
All required fields are marked with a red asterisk *

+ Breadcrumbs
A breadcrumb navigation will be implemented for accessibility, usability and 
SEO.

+ File size restrictions
We do not provide restrictions on the file size inside the Drupal configuration. 
The file size will be limited to the settings provided by the hosting provider.
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GENERAL INFORMATION

+ Control panel

A control panel will be created to be able to modify elements that re-occur on 
several pages. This could for example be used to make a hard coded string 
inside the template editable.
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CONTROL PANEL

+ Language switcher
At the top of the control panel there is language switcher which allows to 
change the configuration of each language.
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CONTROL PANEL

+ News block
Define the title and link title of the news block on the homepage.
If left empty the default text will display.
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CONTROL PANEL

+ Broadcasts block
Define the title and link title of the broadcast block on the homepage.
If left empty the default text will display.
Additionally, you can specify the number of broadcasts to show. 
Note: the broadcasts are only shown on the private (authenticated) homepage

9



NAVIGATION

+ Main navigation

It is possible to add new items inside the menu. This can be obtained by 
adding a menu settings when editing a page.

The menu structure will remain exactly the same for  logged in and logged out 
users. The only difference consists in links that are only available for certain 
visitors.
For this, a separation between public and private links has been created: 
› The private links can only be accessed when the user has logged in,
› The public links are available to all users.

An addition sidebar menu can be created by using the link paragraph.
More about this inside the paragraphs section of this document
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NAVIGATION

+ Sidebar navigation

The sidebar navigation will be placed on all content types except for the 
homepage. It consists of 4 links:
› EMS Tracking 

A link redirecting the users to the tracking content type page
› Reports portal SMART

Links to an external platform
› EMS Operational Guide

Links to an external platform
› i-Care

Links to an external platform

A separate menu will be created to handle these links. 
The links should contain a certain class to be able to display 
the correct icon.

The sidebar navigation will be placed to the side of header image on a 
subpage, and will only be shown for authenticated users.
This way the button do not hover over the text on mobile.
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+ Footer navigation

The footer navigation will be active on all pages and contains the following links
› Contact EMS

This link redirects the page to the contact page
› Sitemap

This links to a page of the type “Content page” that will be used for the HTML 
sitemap. The content type will contain a paragraph implementation that allows to 
insert a custom block. The custom block will contain an automatically generated 
sitemap based on the current user role.

› Disclaimer & confidentially
This links to a page of the type ”Content page”

A separate menu will be created to handle these links.



NAVIGATION

+ Login

A login button will be placed on the top right of the website. If clicked an 
expandable box will open to display a login form.

This will be implemented  by creating a custom block with a Drupal form API 
form inside.

A text should be added to add a disclaimer above the login form.
This text can be modified inside the control panel.

The form components will be hard coded and can only be changed by the 
website provider.
There will be a forgot password and a request account link.

The default Drupal logic will be called from the form submit handler instead of 
using the default Drupal login form. This makes it possible to modify the 
content of the form to the exact needs.
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NAVIGATION

+ Login

After logging in, the login button will be converted to an email address.
Upon hovering this email, an expandable box is shown containing a logout 
button.
The logout button is the only option inside the expandable box.
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NAVIGATION

+ Request a new user account

The request page will be created using a separate content type called ”User 
page”.
This will allow to add the following fields for the content above the form:
› Title *
› Content

The form fields content will be submitted to an email (control panel setting).
EMS will handle this mail manually inside the current existing external user 
management.
The forms will be rendered inside a custom block, which will be linked to a 
certain node id from the “User page” content type. Only the administrator will 
be able to delete this page. Modifications to the content can be made by the 
appropriate users.
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NAVIGATION

+ Request new ems.post account

Since the register form is hard coded, the labels can only be adjusted by the 
website provider.
A new account can be created by filling in a form containing the following fields

› Fieldset: Postal organization
» Postal organization * – Designated / Restricted
» Country * – Dropdown - (A custom country list EMS country region list.xlsx) 

(only for Designated)
» Designated operator * – Dropdown (only for Designated)
» Restricted postal union * – Dropdown (only for Restricted)

› Fieldset: Your information
» Title * (Mr / Mrs / Ms / Dr) – Dropdown
» Name* – Textfield
» Last name* – Textfield
» Email * – Email field
» Phone – Textfield
» Confirmation checkbox * – checkbox

› Submit button: Send

The input fields will be limited to a certain amount of characters. The allowed 
amount of characters for each field will be delivered by EMS. Currently a max 
40 characters will be set as a default.
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NAVIGATION

+ Password 
recovery

Using the forgot password link, it will be possible to request a new password.
When this form is completed, a mail is sent to EMS to notify them of the 
request.

Afterwards, EMS will send the correct password to the user.
The website will not handle any automated solution for this, since the user 
accounts originate from a different system.

This page will be created using the same mechanism created for the request 
user page.

Authentication is done using the EMS Portal Login, providing a SSO 
environment.
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CONTENT TYPES
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+ General

The website will consists of the following content types
› Homepage
› Tracking page
› Report – List
› Report (Not displayed as a separate content type)
› Broadcast – List
› Broadcast
› Operator – List
› Operator
› Content page
› Event – List
› Event
› News – List
› News
› Consultation – List
› Consultation
› User Page

Only the content types marked in blue, can be created. The other types are 
created by the website provider and only consists in the amount that has been 
delivered.
The content inside the existing non-marked pages can however be changed 
by EMS.

Once a  page has been created, it cannot be moved from one content type to 
another.

A page marked as “- List” will be used to list items from the content type 
without ”- List”. Each list page has its own set of field and cannot be converted 
from one list type to another.

The only role that can create or modify content is EMS Unit/board



CONTENT TYPES
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Homepage

+ General

This is the landing page of the website and consists of different sections:
› Header
› Tracking
› Who we are
› News
› Broadcast (Logged in users only)
› What are we doing ? (Logged in users only)

+ Header
The header region consists of a background image that will be stretched on 
the full width of the page. There is a “public” version (for anonymous visitors) 
and a “private” version (for authenticated users). The image area will have a 
fixed height, if the screen width is increased the image will become cropped 
from the bottom.
› Image
› Text
Image dimensions• Public = 1920 x 480 pixels, Private = 1920 x 370 pixels
When an image is too big, the image will get cropped. The cropping result will 
always start in the middle of the image.

+ Tracking

This section will contain a field that allows to enter your tracking number to 
perform a trace of your package.

The labels in this area will be made adjustable inside the control panel.

When the tracking number is submitted, the website is redirected to the 
tracking page with the tracking code and language already filled in.



CONTENT TYPES
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Homepage

+ Who we are ?

This section will contain some information about EMS, and will only be shown 
on the public version of the homepage. The information will be added as fields 
inside the homepage content type:

› Fieldset: Information
» Title * (Who are we ?)   
» Info icon *
 Paragraph: Info icon
 - Title * (Express mail..)  
 - Image *
» Content * (in 1998…)         
» Link (Learn more..)

+ News

The news section will display a list of the 3 latest news items, chronologically 
sorted from left to right (new to old). On the private version of the homepage, 1 
news item is shown “featured” at the top, while 3 other items are shown near 
the bottom.

The news section will be loaded inside a custom block that is added to the 
homepage template.
The following fields will be added to the control panel to allow to edit them:

› Fieldset: News block
» Title * (News)
» Link Title * (See all…)



CONTENT TYPES
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Homepage

+ News

A news item is rendered as a teaser inside the block. The teaser contains the 
following items:

› Title *
› Image
› Link *

“Read more”. This link will be provided automatically.
› Date

A datepicker implementation.

The news section will contain a link to the news list page. 



CONTENT TYPES
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Homepage

+ Broadcasts

A list of the 10 latests EMS broadcasts will be shown inside a section of the 
private homepage, with a link pointing to the full broadcast list.
They will be chronologically sorted by date starting from the most recent item.

The broadcasts will be rendered as a teaser inside a custom block.
This block will be rendered inside the homepage template.

There will be no filtering provided for tracking results on the homepage.
It will be required to visit the tracking page to view the tracking specific 
broadcasts.

The broadcast section is only available for logged in users.



CONTENT TYPES

22

Homepage

+ Broadcasts

The following fields will be added inside the control panel
› Fieldset: Broadcasts block

» Title * (Latest broadcasts)
» Link Title * (See all the …)
» Number of broadcasts to show

A broadcast teaser will contain the following elements:
› Status icon *  (Removed after meeting 22/05/2020)

Taxonomy: Broadcast status
» Red = Issue
» Gray = Pending
» Green = Solved

› Title *
› Date * (Format: 05 12 2020 (PHP = d m Y)) 
› Country  * (Custom list, add a “Global” option to display all countries, see 

EMS country region list.xlsx)
› Broadcast description * (a cropped version limited in characters)
› Link *

This link will be provided automatically



CONTENT TYPES
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Homepage

+ What are we doing ?

This section allows to add a call to action or simple information box into the 
homepage.
It is possible to add a title, description and an optional button or link.

The following fields will be added to the homepage content type:
› Fieldset: What are we doing ?

» Title * (What are …)
» CTA * (Call to action)
 Paragraph: Homepage CTA
 - Title *
 - Content *
 - Button
 The default value for the button is 
 “Read more”

Multiple input is possible
 - Link
 The default value for the link 
 is “Read more”

Multiple input is possible

The “What are we doing ?” section is 
only available for logged in users.



CONTENT TYPES
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Tracking

+ General

Tracking is implemented through an iframe embedding the Paranor tracking 
widget.
The tracking page will be created inside a content type called “Tracking page”.



CONTENT TYPES
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Tracking

+ Integration of the Paranor Tracking Widget

The data provided by this solution will be limited to the possibilities of the 
widget.
In the situation where all data is available, the following items will be rendered:

› Current status bar
› Alerts
› Shipping information

» Current status
» Shipping from
» Shipping to
» Scheduled delivery
» Last location

› Mail carrier
» Carrier name

› Postal organization
» Postal organization name(s)

› Shipment progress
» A list of all progress events

The Google map feature will not be included. (decision 28/06)



CONTENT TYPES
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Operator - List

+ General

The operator list page combines all the operators inside a seperate content 
type. 
The content type contains the following fields:
› Title *
› Content

Displayed above the list

A custom block will be created that is only rendered on the content type 
“Operator – List”.

The page consists of the following sub-elements
› Search 
› Operators



CONTENT TYPES
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Operator - List

+ Search

A search will be implemented and will allow to search using the following 
elements:
› Text

This is a free text search on the title of the operator only
› Operator level 

Taxonomy: Operator level
» Full member
» Import member
» Non member

› Region (Custom list provided by EMS:  EMS country region list.xlsx)
› First letter

A filter from A to Z will be provided above the operators

All keywords of the search are passed using query parameters.
» Example: /operators?continent=1&text=afg...

The search will be provided by a Drupal EntityQuery implementation.
After providing a search query, the list of operators is retrieved an rendered in 
a grid up to 24 items.
If the button “Load all the operators” is pressed, the remaining items are 
shown.

The images will be loaded using data attributes to avoid that all images from 
hidden operators are downloaded on the initial page load.

The search result consists of a teaser view of the operator that contains the 
following elements:
› Image
› Title
› Country (EMS country region list.xlsx)
› Operator level (Icon)



CONTENT TYPES
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Operator - Item

+ General

If an operator has been selected on the operator list page, the detail is shown 
on a seperate page.
These pages will be created inside a content type called ”Operator”

The carousel will be displayed horizontally.
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Operator - Item

+ General

The following operator information will be stored inside the content type:
› Title *

Name of the operator
› Logo *

This logo will be scaled in width only
› Operator level *

Taxonomy: Operator level
» Title *
» Logo *

› Region *
Taxonomy: Region (Continent)
» Title *

Delivered by EMS: EMS country region list.xlsx
› Country

A custom country list
Taxonomy: Countries
» Title *

Delivered by EMS: EMS country region list.xlsx
› Contact link

A link to the external website of the operator
› Email

Validation will take place to validate a correct email
› Phone number
› Website

Validation will take place to validate a correct url
› EMS Email

An Email specifically for EMS
Validation will take place to validate a correct input

› Description
› Images

A carousel containing images from this operator. This will be implemented using a 
multiple input image field. For performance, the field will be limited to 10 images.
When the image is clicked, it is expanded in a lightbox.



CONTENT TYPES
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Operator - Item

+ General

› Product characteristics
Paragraph: Product characteristics
» Title *
» Minimum size *
» Maximum size *
» Icon *
 Taxonomy: Product type
 - Title *
 - Icon *

› Shipment type
Multiple input field that selects a taxonomy term
Taxonomy: Shipment type
» Title *
» Icon *

› Currency
A list of currencties originating from a Drupal pre-defined list or a Taxonomy.
A multiple input select field will be used in the back-office.

› EMS Services
A list of services originating from a Taxonomy called “EMS Services”.

› Operator code *
A text field that allows to insert an operator code

If any of the above non-required fields is empty, the section containing the field 
output will not be shown.

On top of the content type specific fields, all fields from the content page will 
be available.

The titles “Product cha..”, “How can you ...”, “Additional information”, 
“Currentcy used”, “Additinoal EMS services”, can be changed inside the 
control panel. They cannot be overwritten for a single operator.

The text “Pictures of ..” can only by changed by a developer.
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Broadcast - List

+ General

When the button “See all the broadcasts” is clicked on the homepage, a list 
view of all the broadcasts becomes available.

The broadcasts list contains the same content as the list on the homepage.

The content type contains the following fields:
› Title *
› Content

Displayed above the list
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Broadcast - List

+ General

The following filter can be applied:
› Type

The page will display the 10 most recent broadcasts.
When a “Load more broadcasts” button is pressed, another 10 items are 
loaded.
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Broadcast - Item

+ General

If a read more button on the broadcast list is pressed, the detail page of a 
broadcast is shown.

A broadcast consists of the following fields:
› Title *
› Type *

Taxonomy: Broadcast type
» Title *
» Icon *

(Holidays / Natural disasters / Service Disruption / Technical / Force Majeure / EMS 
Cooperative alerts / Other)

› Status * (Removed after meeting 22/05/2020)
Taxonomy : Status (Problem (Red), Pending (Gray), Solved (Green))
» Title *
» Icon *

The status icon will be shown on the top right of the broadcast
› Date * (Format: 05 12 2020 (PHP = d m Y))
› Country *

A broadcast will be linked to a country, not a region. 
It should be possible to have an All selection to display the broadcast everywhere 
(or make it optional).
The country will be constructed from a seperate taxonomy term since not all 
countries can be inside the list.
Delivered by EMS: EMS country region list.xlsx
Taxonomy: Country
» Title * (Name of the country)

› Broadcast description * (limited in characters)

The layout will be based on the news page features.

On top of the content type specific fields, all fields from the content page will 
be available. This will be used to allow to add a list of files to a broadcast.
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Event - List

+ General

A list page will be created for the events:

The content type contains the following fields:
› Title *
› Content

Displayed above the list

This teaser view consists of the following fields:
› Title
› Date

A datepicker implementation.
› Link (Read more)
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Event - List

+ General

No filter is applied to this content type.

The page will display the 10 most recent events.
When a “Load more events” button is pressed, another 10 items are loaded.
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Event - Item

+ General

If a read more button on the event list is pressed, the detail page of an event is 
shown.

An event consists of the following fields:
› Title *
› Date * (Format: 05 12 2020 (PHP = d m Y)) 
› Event type *

Taxonomy: Event type
» Title *

› Link to an external event
› Disable read more

It should be possible to disable the read more button using a checkbox.

On top of the content type specific fields, all fields from the content page will 
be available.
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News - List

+ General

A list page will be created for the news:

The content type contains the following fields:
› Title *
› Content

Displayed above the list
› Archive page

Checkbox

This teaser view consists of the following fields:
› Image
› Title *
› Link *

“Read more”. This link will be provided automatically.
› Date

A datepicker implementation.
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News - List

+ General

The news list is not filterable.

The page will display the 10 most recent news items.
When a “Load more news” button is pressed, another 10 items are loaded.

When a checkbox “Archive page” is selected, the page will render the archived 
news items only.
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News - Item

+ General

If a read more button on the news list is pressed, the detail page of a news 
item is shown.

An news item consists of the following fields:
› Title *
› Image
› Date *

Datepicker - (Format: 05 12 2020 (PHP = d m Y)) 
› Archived

A checkbox marking a news item as archived.
This will remove the news item from the news list and only display it inside the 
archive list page.

On top of the content type specific fields, all fields from the content page will 
be available.
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Consultation - List

+ General

A list page will be created for the consultations:

The content type contains the following fields:
› Title *
› Content

Displayed above the list

This teaser view consists of the following fields:
› Title
› Date

A datepicker implementation.
› Link (Read more)
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Consultation - List

+ General

The consultation list will not be filterable.

The page will display the 10 most recent consultations.
When a “Load more consultations” button is pressed, another 10 items are 
loaded.
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Consultation - Item

+ General

If a read more button on the consultation list is pressed, the detail page of a 
consultation is shown.

An event consists of the following fields:
› Title *
› Date * (Format: 05 12 2020 (PHP = d m Y)) 
› Consultation type *

Taxonomy: Consultation type
» Title *

On top of the content type specific fields, all fields from the content page will 
be available.
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Report - List

+ General

A list page will be created 
for the reports:

The content type contains the following fields:
› Title *
› Content

Displayed above the list

This teaser view consists of the following fields:
› Logo 

Retrieved from the linked operator.
› Country

Retrieved from the linked operator.
› Region

Retrieved from the linked operator.
› Operator code

Retrieved from the linked operator.
› Report

This is a direct download link of the report, no detail page is shown.
A query string will be added to the report, to match the last import date.
This will ensure the old report is not cached.
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Report - List

+ General

The list is filterable by the following filters:
› Country

Dropdown
› Region

Dropdown
› Operator code

Free text field

The list is stored by alphabet and contains a pager to view the follwoing 
pages.

+ Import system
An FTP server will be made available and will link to a defined folder inside the 
sites/default/files folder of Drupal.

When a file is uploaded, it will be matched with the existing list of operators in 
the website. If the operator code from the file name consists with the operator 
code in the operator content type, it will be shown on the website.

The delivered filename will be of the format: AT_ATU.pdf, the first part of the 
filename contains the operator code (AT).

When a file is added into the folder, it is not automatically added into the 
website for performance reasons. A cronjob will process the tasks during the 
night and will add the new reports inside.

Only a single report is stored for each operator. Meaning that an updated 
report will overwrite the existing item.
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Report - Detail

+ General

A detail page view for the reports does not exist. A content type will however 
be created to be able to create the list view.
The report will be downloaded when clicked inside the report list page.

The content type consists of the following fields:
› Title *
› Operator *
› Report *

A file field that allows to upload 1 document.
The document will be in a PDF format.
The limitation on the filesize will be defined by the hosting configuration.
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Content page

+ General

A content type will be created to create all pages that do not belong to a 
certain content type.

The content page will allow to create a page by using a certain set of defined 
content blocks. The blocks can have multiple instances on the same page.
A drag-and-drop system is provided in the back-office to re-arrange the blocks.
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Content page

+ Structure
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Content page

+ Structure

The content page will be split into 2 sections. For this a specific paragraph will 
be created.
The following fields will exist on the content type.

› Title *
› Content blocks *

Paragraph: Structure
» Primary content
 Sub-paragraphs...
» Secondary content
 Sub-paragraphs...

+ Primary content
The primary content (blue) section allows to place the following types of blocks
› Article
› Image
› Video
› Carousel
› Accordion
› Quote
› File
› Link

+ Secondary content (sidebar)
The secondary content blocks (green) section allows to create blocks o the 
type

› File
› Link
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Content page

+ Structure (Normal)

An example of a content page:
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Content page

+ Structure (Full-width)

Some pages do not require a sidebar and should be rendered on the full width 
of the page.
For this the structure block can be ignored, and all Paragraphs can be added 
directly into the content blocks field.
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+ General

The content blocks can be added when editing a page in the back-office.

Some buttons have been added to the front-end to be able to sort and modify 
existing blocks without the need to go to the overview screen of all blocks.

All blocks are created using the Paragraphs module.
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Article

+ Layout
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Article

+ General

The article block will consist of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Image
› Legend 

The legend will be added below the image
› Text *
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Image

+ Layout
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Image

+ General

The image block will consist of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Title
› Image * 
› Legend 

The legend will be added below the image
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Video

+ Layout
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Video

+ General

The image and video block will consist of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Title
› Image * 

An image displayed as long as the video hasn’t been loaded yet
› Video *

Youtube or Vimeo supported. No custom video uploads.
This will be textfield that recognizes the type of video and creates the iframe itself

› Legend 
The legend will be added below the video

› Size
- Small
- Large

The iframe should never be larger then the available space inside the region.
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Carousel

+ Layout
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Carousel

+ General

The carousel block consists of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Title 
› Image

This image can be expanded upon a click
› Link

This can be an external or internal link
If a link is provided, this will override the image expand feature.

There are 2 types of views available for a carousel item
› Image only
› Image + title below

The image will be enlarged when clicked, unless it contains a link.
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Carousel

+ General

On a tablet only 2 elements or 1 large will be shown on each carousel 
iteration.

On a smartphone only 1 element will be shown on each carousel iteration, the 
image of the double size element will be cropped to be able to make it fit inside 
the same dimension as the other elements.

On mobile devices, each carousel iteration can also be triggered with a swipe 
gesture.
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Accordion

+ General

The accordion block consists of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Accordeon item
Paragraph: Accordeon
» Admin title *
 This title is for administrative purposes only and will not be displayed
» Title *
» Content *
 A richt text (wysiwyg) field.

The accordion does not allow any other block inside. Only a wysiwyg field will 
be provided.

The first element of the accordion is always displayed as expanded on the 
page load. The other items stay collapsed until the title is clicked.
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Quote

+ General

The quote block consists of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Quote
Wysiwyg field

› Author
Textfield

› Background-color
A color picket with a set of fixed defined colors. Only the defined colors can be 
picked.
If the background-color is set, the quote icon will not be shown and the quote will 
be rendered in a boxed view.

› Text-color
Pre-defined list of colors
The text-color is only applied when the background-color is active.
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Link

+ General

The link block consists of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Title
› Link *

This can be an internal or external link
It is possible to set a different title for a link.

There is no restriction in the amount of links in a single block.
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File

+ General

The file block consists of the following fields:

› Admin title *
This title is for administrative purposes only and will not be displayed

› Title
› File*

A file will we displayed with an icon in front of it.
The supported file formats are:
doc, docx, docm, xls, xlsx, xlsm, ppt, pptx, pptm, txt, pdf, jpg, jpeg, png, gif

There are no restriction to the amount of files that can be added here.
The file size will be limited to the restrictions of the hosting provider.
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+ General

The Flipbook block consists of the following fields:

› PDF*
This is the PDF-file that will be used as content for the flipbook.

This block displays a flipbook widget, which the visitor can use to browse 
through the uploaded PDF file. More than one flipbook block can be placed on 
a single page.
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Flipbook
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+ Visual specifications

An overview of all the colors and fonts used inside the website:


